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Watershed Analysis with the 
Hydrologic Engineering Center’s 

River Analysis System (HEC-RAS)
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PURPOSE:  The objectives of this document are to provide a general description of the HEC-
RAS model, its capabilities and limitations, data requirements, traditional and innovative 
methods for HEC-RAS hydraulic model calibration, and to present a case study HEC-RAS 
model application whereby the capabilities of HEC-RAS are demonstrated as a means to support 
system-wide modeling and assessment in a usable decision-support framework.  
 
MODEL DESCRIPTION 
 
Overview.   HEC-RAS is an integrated system of software, designed for interactive use in a 
multi-tasking environment.  The system is comprised of a graphical user interface (GUI), 
separate hydraulic analysis components, data storage and management capabilities, graphics and 
reporting facilities. 
 
The HEC-RAS system will ultimately contain three one-dimensional hydraulic analysis 
components for: (1) steady flow water surface profile computations; (2) unsteady flow 
simulation; and (3) movable boundary sediment transport computations.  A key element is that 
all three components will use a common geometric data representation and common geometric 
and hydraulic computation routines.  In addition to the three hydraulic analysis components, the 
system contains several hydraulic design features that can be invoked once the basic water 
surface profiles are computed. 
 
The current version of HEC-RAS supports steady and unsteady flow water surface profile 
calculations.  New features and additional capabilities will be added in future releases.  On-line 
help is available from within the HEC-RAS software.  Help can be accessed by selecting the 
Help menu option at the top of each window, or by pressing the F1 function key. 
 
Capabilities and Limitations.  HEC-RAS is designed to perform one-dimensional hydraulic 
calculations for a full network of natural and constructed channels.  The following is a 
description of the major capabilities of HEC-RAS. 
 
The user interacts with HEC-RAS through a graphical user interface (GUI).  The main focus in 
the design of the interface was to make it easy to use the software, while still maintaining a high 
level of efficiency for the user.  The interface provides for the following functions: 
 
• File management. 
• Data entry and editing. 
• Hydraulic analyses. 
• Tabulation and graphical displays of input and output data. 
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• Reporting facilities. 
• On-line help. 
 
Steady flow water surface profiles.  The Steady Flow Water Surface Profiles component of the 
modeling system is intended for calculating water surface profiles for steady gradually varied 
flow.  The system can handle a full network of channels, a dendritic system, or a single river 
reach.  The steady flow component is capable of modeling subcritical, supercritical, and mixed 
flow regime water surface profiles. 
 
The basic computational procedure is based on the solution of the one-dimensional energy 
equation.  Energy losses are evaluated by friction (Manning's equation) and contraction/ 
expansion (coefficient multiplied by the change in velocity head).  The momentum equation is 
utilized in situations where the water surface profile is rapidly varied.  These situations include 
mixed flow regime calculations (i.e., hydraulic jumps), hydraulics of bridges, and evaluating 
profiles at river confluences (stream junctions). 
 
The effects of various obstructions such as bridges, culverts, weirs, and structures in the flood 
plain may be considered in the computations.  The steady flow system is designed for application 
in flood plain management and flood insurance studies to evaluate floodway encroachments.  
Also, capabilities are available for assessing the change in water surface profiles due to channel 
improvements, and levees.  
 
Unsteady flow simulation.  This component of the HEC-RAS modeling system is capable of 
simulating one-dimensional unsteady flow through a full network of open channels.  The 
unsteady flow equation solver was adapted from Dr. Robert L. Barkau's UNET model (Barkau 
1992, HEC 1997).  This unsteady flow component was developed primarily for subcritical flow 
regime calculations.  However, with the release of Version 3.1, the model can now perform 
mixed flow regime (subcritical, supercritical, hydraulic jumps, and drawdowns) calculations in 
the unsteady flow computations module. The hydraulic calculations for cross sections, bridges, 
culverts, and other hydraulic structures that were developed for the steady flow component were 
incorporated into the unsteady flow module.   
 
Sediment transport/movable boundary computations.  This component of the modeling 
system is intended for the simulation of one-dimensional sediment transport/movable boundary 
calculations resulting from scour and deposition over moderate time periods (typically years, 
although applications to single flood events are possible). 
 
The sediment transport potential is computed by grain size fraction, thereby allowing the 
simulation of hydraulic sorting and armoring.  Major features will include the ability to model a 
full network of streams, channel dredging, various levee and encroachment alternatives, and the 
use of several different equations for the computation of sediment transport. 
 
The model will be designed to simulate long-term trends of scour and deposition in a stream 
channel that might result from modifying the frequency and duration of the water discharge and 
stage, or modifying the channel geometry.  This system can be used to evaluate deposition in 
reservoirs, design channel contractions required to maintain navigation depths, predict the 
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influence of dredging on the rate of deposition, estimate maximum possible scour during large 
flood events, and evaluate sedimentation in fixed channels. 
 
Data storage and management.  Data storage is accomplished through the use of “flat” files 
(ASCII and binary), as well as the HEC-DSS (Data Storage System).  User input data are stored 
in flat files under separate categories of project, plan, geometry, steady flow, unsteady flow, and 
sediment data.  Output data are predominantly stored in separate binary files. Data can be 
transferred between HEC-RAS and other programs by utilizing the HEC-DSS. 
 
Data management is accomplished through the user interface.  The modeler is requested to enter 
a single file name for the project being developed.  Once the project file name is entered, all 
other files are automatically created and named by the interface as needed.  The interface 
provides for renaming, moving, and deleting files on a project-by-project basis. 
 
Graphics and reporting.  Graphics include X-Y plots of the river system schematic, cross 
sections, profiles, rating curves, hydrographs, and many other hydraulic variables.  A three-
dimensional plot of multiple cross sections is also provided.  Tabular output is available.  Users 
can select from pre-defined tables or develop their own customized tables.  All graphical and 
tabular output can be displayed on the screen, sent directly to a printer (or plotter), or passed 
through the Windows Clipboard to other software, such as a word processor or spreadsheet.  
Reporting facilities allow for printed output of input data as well as output data.  Reports can be 
customized as to the amount and type of information desired. 
 
History.  The HEC-RAS modeling system was developed as a part of HEC’s “Next Generation” 
(NexGen) of hydrologic engineering software.  The NexGen project encompasses several aspects 
of hydrologic engineering, including:  rainfall-runoff analysis; river hydraulics; reservoir system 
simulation; flood damage analysis; and real-time river forecasting for reservoir operations. 
 
The first version of HEC-RAS (Version 1.0) was released in July of 1995.  Since that time, there 
have been several releases of this software package, including Versions: 1.1;1.2; 2.0; 2.1; 2.2; 
2.21; 3.0; 3.1; and 3.1.1.  Version 3.0 was the first version to include unsteady flow computa-
tions.  Version 3.1 included the first look at sediment transport, with the introduction of sediment 
transport capacity and stable channel design functions.  Future versions of HEC-RAS will have 
the HEC-6 style sediment transport capabilities, such as temporal analysis of system-wide scour 
and deposition.   
 
General Description.  HEC-RAS is an integrated package of hydraulic analysis programs in 
which the user interacts with the system through the use of a graphical user interface (GUI).  The 
system is capable of performing steady and unsteady flow water surface profile calculations, and 
will include sediment transport and several hydraulic design computations in the future. 
 
In HEC-RAS terminology, a project is a set of data files associated with a particular river 
system.  The modeler can perform any or all of the various types of analyses included in the 
HEC-RAS package as part of the project.  The data files for a project are categorized as follows: 
plan data, geometric data, steady flow data, unsteady flow data, sediment data, and hydraulic 
design data. 
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During the course of a study, the modeler may want to formulate several different plans.  Each 
plan represents a specific set of geometric data and flow data.  Once the basic data are entered 
into the HEC-RAS, the modeler can easily formulate new plans.  After simulations are made for 
the various plans, the results can be compared simultaneously in both tabular and graphical form. 
 
HEC-RAS starts with the main window shown in Figure 1. 
 

Figure 1.   HEC-RAS main window 
 
Entering geometric data.  The next step is to enter the necessary geometric data, which consist 
of connectivity information for the stream system (river system schematic), cross-section data, 
and hydraulic structure data (bridges, culverts, weirs, etc.).  See Figure 2. 
 
After the river system schematic is developed, the modeler can start entering cross-section and 
hydraulic structure data.  The cross section editor is shown in Figure 3.  As shown, each cross 
section has a river name, reach name, river station, and a description.  The river, reach, and river 
station identifiers are used to describe where the cross section is located in the river system.  The 
"River Station" identifier does not have to be the actual river station (miles or kilometers) at 
which the cross section is located on the stream, but it does have to be a numeric value (e.g., 1.1, 
2, 3.5, etc.).  The numeric value is used to place cross sections in the appropriate order within a 
reach.   
 
The basic data required for each cross section are shown on the cross section data editor in 
Figure 3.  Additional cross section features are available under Options from the menu bar.  
These options include: adding, copying, renaming, and deleting cross sections; adjusting cross 
section elevations, stations, and n or k values; skew cross section; ineffective flow areas; levees; 
blocked obstructions; adding a lid to a cross section; adding ice cover; adding a rating curve; 
horizontal variation of n or k values; and vertical variation of n values. 
 
The cross section data editor also has the ability to plot any cross section or reach profile.  Edit 
features are available to cut, copy, paste, insert, and delete data from the Cross Section X-Y 
Coordinates grid. 
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Figure 2.  Geometric data plan view schematic 

 
Once the cross-section data are entered, the modeler can then add hydraulic structures such as 
bridges, culverts, weirs, and spillways.  Data editors, similar to the cross-section data editor, are 
available for the various types of hydraulic structures.  If there are any stream junctions in the 
river system, additional data are required for each junction.  
 
Entering flow data and boundary conditions.  Figure 4 is an example of the steady flow data 
entry form, which is the steady flow data editor.  As shown in Figure 4, steady flow data consist 
of: the number of profiles to be computed; the flow data; and the river system boundary 
conditions.  Boundary conditions are required in order to perform the calculations.  If a 
subcritical flow analysis is going to be performed, then only the downstream boundary 
conditions are required.  If a supercritical flow analysis is going to be performed, then only the 
upstream boundary conditions are required.  If the modeler is going to perform a mixed flow 
regime calculation, then both upstream and downstream boundary conditions are required.  
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Figure 3.  Cross section data editor 

 

 
Figure 4.  Steady flow data editor 
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Performing the hydraulic computations.  Once all of the geometric data and flow data are 
entered, the modeler can begin to perform the hydraulic calculations.  As stated previously, there 
are three types of calculations that can be performed in the current version of HEC-RAS: Steady 
Flow Analysis, Unsteady Flow Analysis, and Hydraulic Design Functions.  The modeler can 
select any of the available hydraulic analyses from the Run menu bar option on the HEC-RAS 
main window.  An example of the Simulation Manager window is shown in Figure 5, which is 
the Steady Flow Analysis window.  Subcritical, Supercritical, or Mixed flow regime calculations 
are available. 
 

 
Figure 5.  Steady Flow Analysis Window 

 
Additional features are available under the Options menu for: performing a floodway 
encroachment analysis; setting locations for calculating flow distribution output; conveyance 
calculation options; friction slope methods; calculation tolerances; critical depth output; critical 
depth computation method; split flow optimization; data checking; setting log file levels; and 
viewing the log file output. 
 
Once the modeler has selected a plan and set all of the calculation options, the steady flow 
calculations can be performed by pressing the compute button at the bottom of the steady flow 
analysis window.  When this button is pressed, the HEC-RAS system packages up all the data 
for the selected plan and writes it to a run file.  The system then runs the steady flow model 
(SNET) and passes it the name of the run file.  This process is executed in a separate window.  
Therefore, the modeler can work on other tasks while it is executing. 
 
Unsteady flow analysis.  The user is required to enter boundary conditions at all of the external 
boundaries of the system, as well as any desired internal locations, and set the initial flow and 
storage area conditions at the beginning of the simulation.  
 
Boundary conditions are entered by first selecting the “Boundary Conditions” tab from the 
Unsteady Flow Data editor, shown in Figure 6.  River, Reach, and River Station locations of  
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Figure 6.  Unsteady flow data editor 
 
the external bounds of the system will automatically be entered into the table.  Boundary 
conditions are entered by first selecting a cell in the table for a particular location, then selecting 
the boundary condition type that is desired at that location.  Not all boundary condition types are 
available for use at all locations.  Users can also add locations for entering internal boundary 
conditions.  Several different types of boundary conditions are available to the user. They are: 
 
• Flow hydrograph. 
• Stage hydrograph. 
• Stage and flow hydrograph. 
• Rating curve. 
• Normal depth. 
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• Lateral inflow hydrograph. 
• Uniform lateral inflow hydrograph. 
• Groundwater interflow. 
• Time series of gate openings. 
• Elevation controlled gate. 
• Navigation dam. 
• Internal observed stage and flow hydrograph. 

 
In addition to the boundary conditions, the user must establish the initial conditions of the system 
at the beginning of the unsteady flow simulation.  Initial conditions consist of flow and stage 
information at each of the cross sections, as well as elevations for any storage areas defined in 
the system.  Initial conditions are established from within the unsteady flow data editor by 
selecting the “Initial Conditions” tab.    
 
Three components are used in performing an unsteady flow analysis within HEC-RAS:  a 
geometric data pre-processor; the unsteady flow simulator; and an output post-processor.  
 
The pre-processor is used to process the geometric data into a series of hydraulic properties 
tables, rating curves, and family of rating curves, this speeds up the unsteady flow calculations.  
Instead of calculating hydraulic variables for each cross section, during each iteration, the 
program interpolates the hydraulic variables from the tables.  The pre-processor must be 
executed at least once, but then only needs to be re-executed if something in the geometric data 
has changed.  Cross sections are processed into tables of elevation versus hydraulic properties of 
areas, conveyances, and storage and hydraulic structures, such as bridges and culverts, are 
converted into families of rating curves that describe the structure as a function of tailwater, 
flow, and headwater.    
 
The unsteady flow computations within HEC-RAS are performed by a modified version of the 
UNET (Unsteady NETwork model) program, developed by Dr. Robert Barkau (Barkau 1992) 
and modified by HEC.  The unsteady flow simulation is actually a three-step process.  First a 
program called RDSS (Read DSS data) runs.  This software reads data from a HEC-DSS file and 
then converts all of the boundary condition time series data into the user-specified computation 
interval.  Next, the UNET program runs.  This software reads the hydraulic properties tables 
computed by the pre-processor, as well as the boundary conditions and flow data from the 
interface and the RDSS program.  The program then performs the unsteady flow calculations.  
The final step is a program called TABLE.  This software takes the results from the UNET 
unsteady flow run and writes them to a HEC-DSS file.  
 
The post-processor is used to compute detailed hydraulic information for a set of user-specified 
time lines during the unsteady flow simulation period.  In general, the unsteady flow computa-
tions only compute stage and flow at all of the computation nodes, as well as stage and flow 
hydrographs at user-specified locations.  If the post-processor is not run, then the user will only 
be able to view the stage and flow hydrographs and no other output from HEC-RAS.  By running 
the post-processor, the user will have all of the available plots and tables for unsteady flow that 
HEC-RAS normally produces for steady flow. 
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Once the post-processor has finished running, the user can view output from all of the HEC-RAS 
plots and tables.  The maximum water surface profile and user-specified instantaneous profiles 
can be viewed by selecting “Profiles” from the “Options” menu on each of the output windows 
(tables or plots).  The overall maximum water surface profile will be labeled “Max W.S.,” while 
the instantaneous profiles are labeled by the date and time.  For example, a profile from January 
5, 1999 at 1:00 p.m. would be labeled “05Jan1999 1300.” 
 
Viewing and printing results.  Once the model has finished all of the computations, the 
modeler can begin viewing the results.  Several output features are available under the View 
option from the main window.  These options include: cross section plots; profile plots; rating 
curve plots; X-Y-Z perspective plots; hydrograph plot (if unsteady flow simulation was 
performed); tabular output at specific locations (Detailed Output Tables); tabular output for 
many locations (Profile Summary Tables); and the summary of errors, warnings, and notes. 
 
Figure 7 is an example of a cross section plot.  The user can plot any cross section by simply 
selecting the appropriate “River,” “Reach,” and “River Station” from the list boxes at the top of 
the plot.  The user can also step through the plots by using the up and down arrow buttons.  
Several plotting features are available under the “Options” menu of the “Cross Section” plot.  
These options include:  zoom in; zoom out; full plot; pan; animate; selecting which plans, 
profiles, and variables to plot; velocity distribution; viewing interpolated cross sections; and 
control over the lines, symbols, labels, scaling, and grid options. 
 

Figure 7.  Cross section plot 
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Hard copy outputs of the graphics can be accomplished in two different ways.  Graphical plots 
can be sent directly from HEC-RAS to whichever printer or plotter the user has defined under 
the Windows Print Manager.  Graphical plots can also be sent to the Windows clipboard.  Once 
the plot is in the clipboard, it can then be pasted into other programs, such as a word processor.  
Both of these options are available from the “File” menu on the various plot windows. 
 
An example of a profile plot is shown in Figure 8.  All of the options available in the cross-
section plot are also available in the profile plot.  Additionally, the user can select which specific 
reaches to plot when a multiple-reach river system is being modeled. 
 

 
Figure 8.  Profile plot 

 
An example of an X-Y-Z perspective plot is shown in Figure 9.  The user has the option of 
defining the starting and ending location for the extent of the plot.  The plot can be rotated left or 
right, and up or down, in order to get different perspectives of the river reach.  The computed 
water surface profiles can be overlaid on top of the cross-section data.  The graphic can be sent 
to the printer or plotter directly, or the plot can be sent through the Windows Clipboard to other 
programs. 
 
Tabular output is available in two different formats.  The first type of tabular output provides 
detailed hydraulic results at a specific cross-section location (detailed output table).  An example 
of this type of tabular output is shown in Figure 10. 
 
The second type of tabular output shows a limited number of hydraulic variables for several 
cross sections and multiple profiles (profile summary tables).  An example of this type of tabular 
output is shown in Figure 11.  Several standard tables are predefined and provided to the user 
under the “Tables” menu from the profile output tables.  Users can also define their own tables 
by specifying what variables they would like to have in a table.  User-specified table headings 
can be saved and then selected later as one of the standard tables available to the project. 
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Figure 9.  X-Y-Z perspective plot of river reach 
 
 
Tabular output can be sent directly to the printer or passed through the clipboard in the same 
manner as the graphical output described previously.  This option is also available under the 
“File” menu on each of the table forms.  
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Figure 10.  Tabular detailed output 

 

Figure 11.  Profile output table 
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SUPPORT SOFTWARE: HEC-GeoRAS:  HEC-GeoRAS is an ArcView GIS extension 
specifically designed to process geospatial data for use with HEC’s River Analysis System 
(HEC-RAS).  The extension allows users with limited GIS experience to create an HEC-RAS 
import file containing geometric attribute data from an existing digital terrain model (DTM) and 
complementary data sets.  Results exported from HEC-RAS may also be processed.  
 
The current version of HEC-GeoRAS creates an import file, referred to as the RAS GIS Import 
File, containing river, reach, and station identifiers; cross-sectional cut lines; cross-sectional 
surface lines; cross-sectional bank stations; downstream reach lengths for the left overbank, main 
channel, and right overbank; and cross-sectional roughness coefficients.  Additional geometric 
data defining levee alignments, ineffective flow areas, and storage areas may be written to the 
RAS GIS import file.  Hydraulic structure data are not written to the import file at this time.  
Water surface profile data and velocity data exported from HEC-RAS may be processed into 
GIS data sets.  Figure 12 illustrates how HEC-GeoRAS works together with HEC-RAS to 
develop a model.   
 
Intended Application of HEC-GeoRAS.  HEC-GeoRAS creates a file of geometric data for 
import into HEC-RAS.  It also enables viewing of exported results from RAS.  The import file is 
created from data extracted from data sets (ArcView shapefiles) and from a Digital Terrain 
Model (DTM).  HEC-GeoRAS requires a DTM represented by a triangulated irregular network 
(TIN). The shapefiles and the DTM are referred to collectively as the RAS themes.  Geometric 
data are developed from calculating the intersection of the RAS themes. 
 
Prior to performing hydraulic computations in HEC-RAS, the geometric data must be imported 
and completed and flow data must be entered.  Once the hydraulic computations are performed, 
exported water surface and velocity results from HEC-RAS may be imported back to the GIS 
using HEC-GeoRAS for spatial analyses such as flood inundation mapping. Figure 13 is a flood 
inundation plot created by HEC-GeoRAS and ArcView.  GIS data are transferred between HEC-
RAS and ArcView using a specifically formatted GIS data exchange file.   
 
Overview of Requirements.  HEC-GeoRAS 3.1 is an ArcView GIS (Environmental Systems 
Research Institute 1996) extension that provides the user with a set of procedures, tools, and 
utilities for the preparation of GIS data for import into RAS and generation of GIS data from 
RAS output.  While the GeoRAS extension is designed for users with limited geographic 
information systems (GIS) experience, knowledge of ArcView GIS is advantageous.  Users, 
however, must have experience modeling with HEC-RAS and have a thorough understanding of 
river hydraulics to properly create and interpret GIS data sets.  
 
Data Requirements.  HEC-GeoRAS requires a DTM in the form of a TIN.  The DTM must 
be a continuous surface that includes the bottom of the river channel and the floodplain to be 
modeled.  Because all cross-sectional data will be extracted from the DTM, only high-resolution 
DTMs should be considered for hydraulic modeling.  Measurement units are relative to those in 
the DTM.  
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Figure 12.  HEC-GeoRAS flowchart 
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Figure 13.  Flood inundation plot 
 
MODEL DEVELOPMENT AND CALIBRATION:  The primary steps involved in the 
development and calibration of an HEC-RAS model are outlined below: 
 
Collection of Geographic and Hydrographic Data.   This step can be as simple as 
determining the structural dimensions of a concrete-lined canal or as complicated as performing 
a full-coverage survey of the study area, including in-channel hydrosurveys.  Typically, the 
effort is somewhere in between these two extremes.  The traditional method is to survey 
individual cross sections at strategic locations, such as at slope changes, changes in land use, 
around bridges, etc.  More and more common is the full coverage survey approach, in which the 
entire study area is surveyed and stored electronically as a digital terrain model (DTM).  From 
this DTM, the software user can cut cross sections at any location desired.  This step is usually 
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the most expensive and time-consuming.  Included in this first step is the collection of high 
water marks and/or gauge data for use in the calibration step. 
 
Collection of Hydrologic Data.  Hydrologic data are collected and analyzed to determine the 
boundary conditions for the HEC-RAS model.  A simple steady flow, sub-critical model will 
only require a downstream stage and an upstream inflow as boundary conditions.  More complex 
models may have multiple inflow and outlet boundary conditions.  Typically, for a steady flow 
model, frequency events (i.e, 100-year, 20-year, etc.) are used as inflow boundary controls.  In 
unsteady models, inflow hydrographs, representing a time-series of flows (real or fictitious) are 
used to define the inflow boundary control.  Outlet boundary controls include normal depth, 
critical depth, rating curves, flow and stage hydrographs, or tidal cycles.   
 
Input of Data.  This step can be accomplished by manually entering in cross section and 
boundary condition data, or through GeoRAS.  Generally speaking, this includes station-
elevation data for each cross section, roughness values, ineffective flow areas, hydraulic 
structure (bridges, culverts, dams) geometry, and boundary conditions.   
 
Run the Model.  Running the model may take seconds or many hours, depending upon its size 
and complexity.  Usually steady state models are completed in seconds or minutes.  Unsteady 
flow simulations with small time-steps, and a large number of cross sections can take many 
hours.  Depending on the results, adjustments can be made to the model input.  This is necessary 
if errors are reported, or if the model run fails, as in the case of severe instabilities for unsteady 
flow models.   
 
Calibrate the Model.  Once the model has successfully run, the results must be validated by 
calibrating to one or more known events.   Observed points can be entered into the model output 
for direct comparison with model results.  The model input should then be adjusted to try to 
match the model output with the observed points.  Ideally, input that has the most uncertainty 
(roughness values, placement of ineffective flow areas, coefficients, etc.) should be adjusted, 
within reason, to arrive at a fully calibrated model. 
 
Analyze the Results.  A variety of output options are available for use in HEC-RAS.  Profile 
plots, cross-section plots, 3-D perspective plots, and tables can all be used to compile the results 
in useable tools for making design decisions.  Most commonly, water surface elevations for 
various frequency events are desired for floodplain/inundation mapping, levee levels of 
protection determination, and navigation studies.   
 
CASE STUDY APPLICATION-ANACOSTIA RIVER:  The purpose of this study was to 
provide the Baltimore District of the U.S. Army Corps of Engineers (NAB) with an HEC-RAS 
model of the Anacostia River from the Queens Chapel Bridge on the Northwest Branch and the 
East-West Highway on the Northeast Branch down to the Bladensburg Marina on the main stem. 
 The HEC-RAS model was developed from a combination of digital terrain data, existing HEC-
RAS and HEC-2 models, CADD-generated cross sections, surveyed cross-section data, and site 
visits. 
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The goal of the modeling effort was to evaluate the conditions on the Northwest and Northeast 
Branches of the Anacostia River up to the 500-year flood, including areas of levee and high 
ground overtopping, and to provide NAB with a useable tool for future evaluations. 
 
Development.  The HEC-RAS model was developed by importing cross-section data extracted 
from the ArcView GIS system.  The RAS GIS Import File contained the river system schematic, 
cross-section station and elevation points, bank stations, reach lengths between cross sections, 
ineffective flow area locations, and Manning’s n values.  Once the terrain cross sections were 
imported, bathymetric data were inserted in these cross sections where available.  When not 
available, the bathymetric data were interpolated or extrapolated, using the HEC-RAS 
interpolation routines and adjusted to represent actual conditions at bends, bridges, and other 
known features.  The next step was to complete the missing cross-sectional data and modify 
existing data, which includes Manning’s n values, contraction and expansion coefficients, 
ineffective flow areas, and levees.  All plans were run in mixed flow regime, primarily to 
account for the supercritical flow experienced under most conditions in a high-velocity channel 
constructed for flood control.   
 
Calibration.  Because of the uncertainty involved with many of the input parameters used in 
hydraulic models, calibration is a necessary step to ensure confidence in the results.  To calibrate 
this HEC-RAS model of the Anacostia River, two gauges and a physical model study were used. 
 The two stage gauges are located on the upper ends of each of the tributary branches and are 
operated and maintained by the USGS.   
 
To correctly calibrate the model to historical events, recent changes to the river had to be left out 
of the geometry file.  More specifically, the environmental restoration efforts being undertaken 
to improve fish habitat were left out of the “current conditions” model.  Once the model was 
calibrated, all of the geometry was copied to a new geometry file (“future conditions”), and the 
environmental restoration changes were added in.  For the northwest branch, this included an 
increase of the n value in the main channel between river station 4740 and the 38th St. Bridge 
from 0.035 to 0.07 to simulate a boulder garden.  On the Northeast branch, a smaller fish habitat 
improvement was found just downstream of the Riverdale Road Bridge.  This is captured in the 
“future conditions” model with an increase in n value from 0.03 to 0.05 at river station 17986.  
Figures 14 and 15 show the calibration results at the two gauge locations, indicating the RAS-
computed water surface elevations (WS), and the observed water surface elevations (OWS). 
 
Results.  The purpose of this study was to determine the approximate capacity of the levees 
along the northwest, northeast, and main stems of the Anacostia River.  For the analysis, three 
RAS plans were studied:  the Northwest, Northeast, and Mainstem Centering-Future Conditions. 
These plans are labeled future conditions, because they are set up to include further 
environmental enhancements, and other in-river changes.  Currently, the only environmental 
enhancements added into these plans are the boulder garden just upstream of the 38th St. Bridge 
on the Northwest Branch, and the rocky fish habitat improvement just downstream of the 
Riverdale Road Bridge on the Northeast Branch.  Others changes can be easily added in by 
adjusting n values, or physically altering the cross-section geometry.   
 



ERDC/TN SMART-04-2 
September 2004 

19 

 

Figure 14.  Calibration results at Hyattsville Gauge, Northwest Branch Centering 
 

Figure 15.  Calibration results at Riverdale Gauge, Northeast Branch Centering 
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Based on the future conditions, it was determined that the levees contain the 100-year (1-percent 
chance exceedence) event, with the exception of the extreme upper limits of the Northwest 
Branch.  While the levee system did not contain the 200-year event everywhere, it appears that 
the Northeast Branch levee system can contain lower frequency flows than the Northwest 
Branch.  The Arundel Rd. Canal appears to follow the same trend as the two main branches.  The 
200-year profile briefly overtops the right levee just upstream of the 37th St. Bridge.  The 500-
year profile overtops the levees at all points along the canal.  The main stem of the Anacostia 
River contains the 200-year profile within its levees at all points except at river station 6372.  
The 500-year profile is still well contained between the main stem levees, with breaches 
occurring on the left levee at river stations 8625, 6737, and 6372.   
 
POINTS OF CONTACT:  This technical note was written by the Hydrologic Engineering 
Center, Hydrology and Hydraulics Technologies Center, Davis, CA, using excerpts from HEC 
publications and original work.  For additional information, contact Mr. Gary Brunner (530-756-
1104, gary.w.brunner@usace.army.mil), or the Manager of the System-wide Modeling, 
Assessment, and Restoration Technologies (SMART) Program, Dr. Steve Ashby (601-634-2387, 
Steven.L.Ashby@erdc.usace.army.mil).  This technical note should be cited as follows: 
 

Goodell, C. R., and Brunner, G. W.  (2004).  “Watershed Analysis with the Hydrologic 
Engineering Center’s River Analysis System (HEC-RAS),” SMART Technical Notes 
Collection (ERDC/TN SMART-04-2), U.S. Army Engineer Research and Development 
Center, Vicksburg, MS.    
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